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Introduction

This example demonstrates how to use the Uncertainty Quantification Module by running
a series of uncertainty quantification studies for a steel bracket.

This type of bracket can be used to install an actuator that is mounted on a pin placed
between the two holes in the bracket arms. The design objective is that the actuator’s

horizontal misalignment, ¢, should not be too large.

Figure 1: Bracket geometry with the quantity of interest, the misalignment angle, @,
indicated.

Note: The geometry is created using the 3D fillet functionality that is available in the
Design Module. If you do not have access to the Design Module, a version without 3D
fillets is also provided; see Uncertainty Quantification of a Bracket. A few of the model
parameters are slightly changed for the version without fillets but otherwise the

instructions are identical.
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Model Definition

The geometry is fully parameterized with parameters according to the table shown in

Figure 2.

Settings
Parameters

Label: Parameters 1

~ Parameters

L .
Mame Expression

cd Ip/2+ts

hf wp

da_r3 (Ip-wf)/2
db_r3 hf/3

2 hm/2

ts 0.008[m]
Ip 0.19[m]

Is 0.35[m]
hm 0.1[m]
wp 0.1075[m]
wf 0.0625[m]
r3 0.007[m]
al 0.023[m]
fri 0.01[m]

Value
0.103 m
0.1075 m
0.06375 m
0.0215 m
0.05m
0.008 m
0.19m
035m
0.1m
0.1075 m
0.0625 m
0.007 m
0.025 m
001 m

Figure 2: Geometry parameters.
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Description
Work-plane position
Flange height
Flange-hole x-position
Flange-hole y-position
Large side round
Material thickness
Cross-plate length
Side length

Side height
Cross-plate width
Flange width
Bolt-hole radius
Pin-hole radius

Fillet radius
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The mesh is customized to have about two elements across the thickness of the material.

Meshed geometry.

Figure 3

In this analysis, the mounting bolts are assumed to be fixed and securely bonded to the

bracket. One of the arms is loaded upward and the other downward. The loads are applied

UNCERTAINTY QUANTIFICATION OF A BRACKET
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as a pressure on the inner surfaces of the holes, and their intensity is Pycos(a), where o is
the angle from the direction of the load resultants.

Boundary Loads (solid)

(o] MPa

Figure 4: Applied loads.

This force is assumed not to vary in the uncertainty quantification studies. Similarly, the
material properties for a generic structural steel are assumed not to vary.

The misalignment angle is chosen as the quantity of interest (Qol). The design objective
is that the actuator’s horizontal misalignment angle ¢ does not exceed 0.1 degree. The

angle is defined as a variable; for details, see the Modeling Instructions section.

The parameters to be varied are the geometric dimensions of the bracket.
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The parameters that participate in the uncertainty quantification analysis are all assumed
to be normally distributed around their nominal values according to the table in Figure 5,
which corresponds to the screening and sensitivity studies, as described later.

Input parameters table

" barameter Distribution Distribution parameter 1 | Distribution parameter2 | CDF-Lower | CDF-Upper | Lowerbound | Upper bound | Unit
ts (Material thickness) | Normal(po) ~ s 001t Manual = | Manual ~ 089t 107t m
Ip (Cross platelength)  » | Normalino) ~+ Ip 001°lp Manual = | Manual v 095'p 1.05p m
Is (Side length) + | Nomalfpo) ~ |Is 001s Manual = | Manual | 095ls 1.05%1s m
hm (Side height) * | Nomalfuo) ~ hm 0.01*hm Manual = | Manual ~ 095*hm 1.05%hm m
wp (Cross platewidth) +  Nommalfpo) ~ wp 001*wp Manual = | Manual v 0.95wp 1.05%wp m
w (Flange width) + | Nomallpo) ~ wf 001" wf Manual = | Manual ~ | 095%f 1.05%wf m
i1 (Fillet radius) v | Nomallpa) ~ fr1 00171 Manual = | Manual ~ 0951 1.05°r1 m
1 (Pin hole radius) +  Nomalfpo) ~+ rl 0014 Manual = | Manual v | 0951 1,051 m

Figurve 5: Input-parameter distributions used in screening and sensitivity studies.

THE UNCERTAINTY QUANTIFICATION STUDIES
The Uncertainty Quantification Module provides four different study types:
* Screening, MOAT

- Identifies the most influential inputs, for each Qol

- Is based on the Morris One-At-a-Time (MOAT) method

- Outputs MOAT mean and MOAT standard deviation values
* Sensitivity Analysis

- Computes the fraction of impact for the inputs, for each Qol

- Outputs first-order and total Sobol indices
* Uncertainty Propagation

- Computes the statistical variation of the Qol

- Outputs a kernel density estimation (KDE) plot representing an estimate of the
probability distribution of the Qol

* Reliability Analysis
- Computes the probability for the fulfillment of a condition based on the Qol
- For example, what is the probability P(¢ > 0.1)

¢ Inverse Uncertainty Quantification

- Uses experimental data to backtrack and uncover the statistical properties of certain
input parameters, starting with some initial assumptions about them (prior
probability distribution).

- Applies surrogate models and statistical methods to refine the characterization of

these inputs, providing (posterior) probability distributions, as well as a confidence
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interval table containing the mean, standard deviation, min/max values, and

confidence bounds.
This example illustrates the first four of these study types.

For more information, see the Uncertainty Quantification Module User’s Guide.

SURROGATE MODELS

To get statistical data based on a physics model you need to run a lot of simulations,
varying the parameters of the inputs according to their probability distributions. For a 3D
model, this might be computationally unfeasible. To get around this problem, the
Uncertainty Quantification Module first builds up a so-called surrogate model that is used
for sensitivity analysis, uncertainty propagation, and reliability analysis (but not for

screening).

This process is typically adaptive and the surrogate model can approximate the original
model to a high degree of accuracy (which can be modified by the user). The Uncertainty
Quantification Module uses two different types of surrogate models:

* Sparse Polynomial Chaos Expansion (SPCE)

- This surrogate model improves its accuracy by adaptively solving the full model and
thereby adding new Qol data by using sequential Latin hypercube sampling.

* Gaussian Process (GDP)

- This surrogate model improves its accuracy by, using information from the current
Gaussian Process surrogate model, adaptively solve the full model for new carefully

selected sets of parameter values.
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Results and Discussion

The uncertainty quantification study gives the kernel density estimation plot shown in
Figure 6 with associated confidence interval information in the QOI confidence interval
table, as shown in Figure 7.

Line Graph: KDE, comp1.phi
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Figure 6: Kernel density estimation.

Messages Progress Log Qol confidence interval
B HMES-E® \Iel9RCEE -

Mean | STD Minimum | Maximum | Lower 30% | Upper 90% | Lower 95% | Upper93% | Lower 99%  Upper 99%
compl.phi |0.000696(0.0032590(0.079472  |0.10570 0.085481 0.006169  (0.084432  |0.097284  |0.082531 0.099484

Figure 7: Qol confidence interval.
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The reliability analysis study shows that the probability for the misalignment angle ¢ not
to exceed 0.1 degree is about 0.003 or 0.3%. This result is made available in the Probability

for conditions table, as shown in Figure 8.

Messages Progress Log  Probability for conditions
B HEE s B \ I el98C=2H -

Probability for conditions
0.0030304

Figure 8: Probability for conditions.

Note that this value is sensitive to minute changes in the mesh and may vary slightly

depending on the COMSOL Multiphysics version you are running.

It is now up to the designer to decide whether this is an acceptable level or risk or if a

redesign and/or further studies are needed.

To be more conservative about the uncertainty propagation and reliability analysis, we can
choose to include all parameters in the analysis. Running the computationally much more
demanding uncertainty propagation and reliability analysis for all parameters (not
demonstrated here) shows that the probability for the misalignment angle g not to exceed
0.1 degree is about 0.8%.

Application Library path: Uncertainty_Quantification_Module/Tutorials/
bracket_uncertainty_quantification_fillet

Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click [l 3D.

2 In the Select Physics tree, select Structural Mechanics > Solid Mechanics (solid).
3 Click Add.
4 Click e Study.
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5 In the Select Study tree, sclect General Studies > Stationary.
6 Click [ Done.

GEOMETRY 1|

I In the Model Builder window, under Component | (compl) click Geometry 1.
2 In the Settings window for Geometry, locate the Advanced section.

3 From the Geometry representation list, choose CAD kernel. This is necessary because the

prepared geometry sequence contains a Fillet feature.
4 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

5 Browse to the model’s Application Libraries folder and double-click the file
bracket_uncertainty_quantification_fillet_geom_sequence.mph.

6 In the Geometry toolbar, click [E2 Build All.

GLOBAL DEFINITIONS

The geometry sequence already provided a set of geometry dimension parameters. Now

define this additional set of parameters for the boundary load and mesh density.
Parameters 2

I In the Home toolbar, click Fi Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

PO 2.5[MPa] 2.5E6 Pa Force per area

dx lp+ts 0.198 m X-distance between pin holes
hmax ts/1.5 0.0053333 m Max element size

hmin ts/2.5 0.0032 m Min element size

YC -1s+r2 -03m Y-coordinate of hole center

ADD MATERIAL
I In the Materials toolbar, click #27 Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-in > Structural steel.

4 Click the Add to Component button in the window toolbar.
5

In the Materials toolbar, click 35 Add Material to close the Add Material window.
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DEFINITIONS

Next, define a series of Explicit selections to be used for the constraints and loads.

Bolt Holes

I In the Model Builder window, expand the Component | (compl) > Definitions node.
Right-click Definitions and choose Selections > Explicit.

2
3 In the Settings window for Explicit, locate the Input Entities section.
4 From the Geometric entity level list, choose Boundary.

5

Select the Group by continuous tangent checkbox. This setting greatly facilitates the
selection of curved surfaces. In this case use it to select the four bolt holes. It is sufficient
to select one boundary per hole; the three other boundaries will be selected

automatically.

6 In the Label text field, type Bolt Holes.

Left Pin Hole

I In the Definitions toolbar, click g Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.
3 From the Geometric entity level list, choose Boundary.

4 Sclect the Group by continuous tangent checkbox.
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5 Select Boundaries 4, 5, 7, and 8 only.

y‘\T/'X

-01

6 In the Label text field, type Left Pin Hole.

Right Pin Hole

I In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.
3 From the Geometric entity level list, choose Boundary.

4 Seclect the Group by continuous tangent checkbox.
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5 Select Boundaries 52-55 only.

6 In the Label text field, type Right Pin Hole.

Pin Holes A
I In the Definitions toolbar, click @l. Union.

In the Settings window for Union, locate the Geometric Entity Level section.
From the Level list, choose Boundary.
Locate the Input Entities section. Under Selections to add, click - Add.

2
3
4
5 In the Add dialog, in the Selections to add list, choose Left Pin Hole and Right Pin Hole.
6 Click OK.

7

In the Settings window for Union, type Pin Holes in the Label text ficld.

Define average operators that will be used for computing the average z-directional

displacement of the pin holes.

Average | (aveopl)

I In the Definitions toolbar, click (//0 Nonlocal Couplings and choose Average.
2 In the Settings window for Average, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Left Pin Hole.
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Average 2 (aveop2)

I In the Definitions toolbar, click (//// Nonlocal Couplings and choose Average.
2 In the Settings window for Average, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Right Pin Hole.

Variables |

I Right-click Definitions and choose Variables.

Define the quantity of interest (Qol), the misalignment angle, as well as auxiliary
variables for the pin hole z-coordinates.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

Name Expression Unit Description

z1 aveopl(w) m Left pin hole center
z2 aveop2(w) m Right pin hole center
phi atan((z2-z1)/dx)[1/deg] Misalignment angle

The output from the atan() function has the unit radian, which is unitless. The

conversion factor [1/deg] corresponds to multiplication by 180/pi for converting to
degrees.

Now, define an analytic function load used to apply the spatially varying load on the pin
holes.

Analytic | (anl)
I In the Definitions toolbar, click f&: Analytic.
2 In the Settings window for Analytic, type load in the Function name text field.

3 Locate the Definition section. In the Expression text field, type F*cos (atan2(py,
abs(px))).

4 In the Arguments text field, type F, py, px.
5 Locate the Units section. In the Function text field, type Pa.

6 In the table, enter the following settings:

Argument  Unit
F Pa
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Argument Unit

Py m
px m
MESH |

I In the Model Builder window, under Component | (compl) click Mesh 1.
2 In the Settings window for Mesh, locate the Sequence Type section.
3 From the list, choose User-controlled mesh.

Ensure that the mesh density is fine enough to resolve all the stress gradients reasonably

well.

Size

I In the Model Builder window, under Component | (compl) > Mesh | click Size.
2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type

hmax.
5 In the Minimum element size text field, type hmin.

6 Click [E§ Build Al

SOLID MECHANICS (SOLID)

Apply fixed constraint boundary conditions on the bolt holes.

Fixed Constraint |

I In the Physics toolbar, click |mw Boundaries and choose Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose Bolt Holes.
Next, apply the spatially varying load.

Boundary Load |
I In the Physics toolbar, click mw Boundaries and choose Boundary Load.

2 In the Settings window for Boundary Load, locate the Coordinate System Selection

section.

3 From the Coordinate system list, choose Boundary System 1 (sysl).
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4 Locate the Force section. Specify the f5 vector as

0 tl
0 t2
load(-P0,Y-YC,Z)*(sign(X)*Z>0) n

5 Locate the Boundary Selection section. From the Selection list, choose Pin Holes.
STUDY I, STATIC
First, run a static analysis with no uncertainty quantification analysis.

I In the Model Builder window, click Study I.
2 In the Settings window for Study, type Study 1, Static in the Label text field.

3 In the Study toolbar, click = Compute.

RESULTS

Volume |
Now, let us assume that we are only interested in values up to 100 MPa.

I In the Model Builder window, expand the Stress (solid) node, then click Volume 1.
In the Settings window for Velume, click to expand the Range section.
Locate the Expression section. From the Unit list, choose MPa.

In the Stress (solid) toolbar, click Plot.

2
3
4
5 Locate the Range section. Select the Manual color range checkbox.
6 In the Minimum text field, type O.

7

In the Maximum text field, type 100.
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8 In the Stress (solid) toolbar, click Plot.

Volume: von Mises stress (MPa)
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STUDY I, STATIC
In the Model Builder window, right-click Study I, Static and choose More Study Extensions
> Add Uncertainty Quantification Study Using Study Reference.

STUDY 2, SCREENING
In the Settings window for Study, type Study 2, Screening in the Label text field.

Next, add a screening analysis to see which input parameters are most significantly
impacting the misalignment angle (Qol). The screening study is added as a study reference

which means it refers back to the already defined static study.

The parameters that participate in the uncertainty quantification are all assumed to be
normally distributed around their nominal values, according to the instructions below.
The mean and standard deviation, as well as the max and min limits are all defined in terms

of their nominal parameters (from Global Definitions > Parameters).
Uncertainty Quantification
I In the Model Builder window, under Study 2, Screening click Uncertainty Quantification.

2 In the Settings window for Uncertainty Quantification, locate the Quantities of Interest

section.

3 Click + Add.
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4 In the table, enter the following settings:

Expression Include study-dependent input

compi.phi Reduce to single global output

5 Locate the Input Parameters scction. Click 1 Add cight times.

6 In the table, enter the following settings:

Parameter Source type Source description
ts (Material thickness) Analytic Uniform
Ip (Cross-plate length) Analytic Uniform
Is (Side length) Analytic Uniform
hm (Side height) Analytic Uniform
wp (Cross-plate width) Analytic Uniform
wf (Flange width) Analytic Uniform
frl (Fillet radius) Analytic Uniform
rl (Pin-hole radius) Analytic Uniform

7 In the table, click to select the cell at row number 1 and column number 1.
8 From the Distribution list, choose Normal(L,G).

9 In the Mean text field, type ts.

10 In the Standard deviation text field, type 0.01*ts.

Il From the CDF-Lower list, choose Manual.

12 From the CDF-Upper list, choose Manual.

13 In the Lower bound text field, type 0.99*ts.

14 In the Upper bound text field, type 1.01*ts.

I5 In the Unit text field, type m.

16 In the table, click to select the cell at row number 2 and column number 1.
17 From the Distribution list, choose Normal(L,G).

I8 In the Mean text field, type 1p.

19 In the Standard deviation text field, type 0.01*1p.

2 From the CDF-Lower list, choose Manual.

2l From the CDF-Upper list, choose Manual.

22 In the Lower bound text field, type 0.95*1p.
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B In the Upper bound text field, type 1.05*1p.

24 In the Unit text field, type m.

25 In the table, click to select the cell at row number 3 and column number 1.
2% From the Distribution list, choose Normal(L,G).

Z7 In the Mean text field, type 1s.

28 In the Standard deviation text field, type 0.01*1s.

29 From the CDF-Lower list, choose Manual.

30 From the CDF-Upper list, choose Manual.

3l In the Lower bound text field, type 0.95*1s.

32 In the Upper bound text field, type 1.05*%1s.

3B In the Unit text field, type m.

34 In the table, click to select the cell at row number 4 and column number 1.
35 From the Distribution list, choose Normal(L,G).

36 In the Mean text field, type hm.

37 In the Standard deviation text field, type 0.01*hm.

38 From the CDF-Lower list, choose Manual.

39 From the CDF-Upper list, choose Manual.

4 In the Lower bound text field, type 0.95*hm.

41 In the Upper bound text field, type 1.05*hm.

4 In the Unit text field, type m.

8 In the table, click to select the cell at row number 5 and column number 1.
4 From the Distribution list, choose Normal(L,G).

4 In the Mean text field, type wp.

4 In the Standard deviation text field, type 0.01*wp.

47 From the CDF-Lower list, choose Manual.

4 From the CDF-Upper list, choose Manual.

4 In the Lower bound text field, type 0.95*wp.

5 In the Upper bound text field, type 1.05*wp.

51 In the Unit text field, type m.

52 In the table, click to select the cell at row number 6 and column number 1.

5 From the Distribution list, choose Normal(L,G).

19 | UNCERTAINTY QUANTIFICATION OF A BRACKET — FILLET VERSION



54 In the Mean text field, type wf.

5 In the Standard deviation text field, type 0.01*wf.

5 From the CDF-Lower list, choose Manual.

57 From the CDF-Upper list, choose Manual.

58 In the Lower bound text field, type 0.95*wf.
59 In the Upper bound text field, type 1.05*wf.
60 In the Unit text field, type m.

6l In the table, click to select the cell at row number 7 and column number 1.

& From the Distribution list, choose Normal(u,G).

& In the Mean text field, type fri.

64 In the Standard deviation text field, type 0.01*fr1.

65 From the CDF-Lower list, choose Manual.

66 From the CDF-Upper list, choose Manual.

67 In the Lower bound text field, type 0.95*fr1.
6 In the Upper bound text field, type 1.05*fr1.
6 In the Unit text field, type m.

M In the table, click to select the cell at row number 8 and column number 1.

71 From the Distribution list, choose Normal(,G).

72 In the Mean text field, type ri.

B In the Standard deviation text field, type 0.01*r1.

74 From the CDF-Lower list, choose Manual.

75 From the CDF-Upper list, choose Manual.

7 In the Lower bound text field, type 0.95*r1.
77 In the Upper bound text field, type 1.05*r1.
8 In the Unit text field, type m.

P In the Study toolbar, click = Compute.
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RESULTS

MOAT, comp | .phi
I Click the Zoom Extents button in the Graphics toolbar.
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The screening results indicate that the Side length (1s) and the Cross plate width (wp)
parameters are the most influential on the quantity of interest. However, several of the
other parameters also appear to be significant. A high value of the MOAT mean means
that the parameter is significantly influencing the quantity of interest. A high value of
the MOAT standard deviation means that the parameter is influential and that it is either

interacting with other parameters and /or that it has a nonlinear influence.

STUDY 2, SCREENING

The next step is a sensitivity analysis. Use the results from the screening to decide which
parameters to include in the sensitivity analysis. Sensitivity is more computationally
demanding than screening and for this reason we would prefer to pick a subset of the
parameters used for the screening study. However, in this example, we would like to learn
as much as possible about the model and we pick all the available design parameters. We
do not need to type all of the uncertainty quantification parameters again but we can
define the new Uncertainty Quantification study for the sensitivity analysis by reusing the

information in the screening study.
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Uncertainty Quantification
Right-click Uncertainty Quantification and choose
Add New Uncertainty Quantification Study For > Sensitivity Analysis.

STUDY 3, SENSITIVITY
I In the Model Builder window, click Study 3.

2 In the Settings window for Study, type Study 3, Sensitivity in the Label text field.

I In the Model Builder window, under Study 3, Sensitivity click Uncertainty Quantification.

2 In the Settings window for Uncertainty Quantification, locate the
Uncertainty Quantification Settings section.

3 From the Compute action list, choosc Compute and analyze.

4 In the Study toolbar, click = Compute.

RESULTS

Sobol Index, Qoll

Sobol index: comp1.phi
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First-order and total Sobol indices

Input parameter
The sensitivity analysis is based on the Sobol method, also known as variance-based
sensitivity analysis. The result of the sensitivity analysis is a set of Sobol indices and an
associated Sobol table and Sobol plot. There are two different types of Sobol indices: first-
order index and total index. The first-order index of a parameter shows the sensitivity by
varying this parameter alone. The total index shows how much a parameter contributes to

the overall sensitivity.
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In this case, the first and total indices are equal, up to the computed accuracy, for all
parameters which indicates very little or no interaction between the parameters. The Sobol
plot indicates that the misalignment angle is most sensitive to the parameters Side length

(1s) and Cross plate width (wp). This is consistent with the screening results.

For the final two studies, Uncertainty Propagation and Reliability Analysis, we will, for the
purpose of faster demonstration, delete all parameters except for the dominant two: 1s and
wp. However, to get a conservative estimate of the uncertainties we should in principle

include all parameters (see earlier comment).

STUDY 3, SENSITIVITY

Uncertainty Quantification
Right-click Uncertainty Quantification and choose
Add New Uncertainty Quantification Study For > Uncertainty Propagation.

STUDY 4, PROPAGATION
I In the Model Builder window, click Study 4.

2 In the Settings window for Study, type Study 4, Propagation in the Label text field.

I In the Model Builder window, under Study 4, Propagation click

Uncertainty Quantification.

2 In the Settings window for Uncertainty Quantification, locate the Input Parameters

section.

3 Ctrl-click to select table rows 1, 2, 4, and 6-8. This is most easily done by first clicking
in the table’s upper-left corner and then dragging the bottom border of the pop-out
table downward until you see all rows at once. The rows to select are those for the
parameters ts, 1p, hm, wf, fr1, and r1.

4 Click Delete.

-—x

5 Locate the Uncertainty Quantification Settings section. From the Compute action list,
choose Compute and analyze. The default Compute action is Improve and analyze. This
will reuse the previously computed uncertainty quantification results in order to speed
up the computation. However, we are changing to Compute and analyze, which is

slower, but gives a higher-fidelity result.

Uncertainty Quantification 3
In the Study toolbar, click = Compute.
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RESULTS

Kernel Density Estimation, Qol |
I In the Model Builder window, under Results > Uncertainty Quantification Graph 2 click
Kernel Density Estimation, Qoll.
Line Graph: KDE, comp1.phi
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The uncertainty propagation study computes a so called kernel density estimation or
KDE. You can think of the KDE as a smooth form of a histogram showing an estimate
of the probability density function of the quantity of interest, given the input parameters
and their distributions. We can see from the Qol confidence interval table, shown earlier
in the Results and Discussion section, that the mean is about 0.09 degree with a
standard deviation of 0.003 degree. The KDE plot gives us this information graphically.
From the values in the table we can also see that there appears to be some risk that the

angle exceeds 0.1 degree.

To get a more accurate estimate of the risk for exceeding 0.1 degree, we will next run a

reliability analysis.

STUDY 4, PROPAGATION

Uncertainty Quantification

In the Model Builder window, under Study 4, Propagation right-click

Uncertainty Quantification and choose Add New Uncertainty Quantification Study For >
Reliability Analysis.
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STUDY 5, RELIABILITY

1
2

In the Model Builder window, click Study 5.

In the Settings window for Study, type Study 5, Reliability in the Label text field.

In the Model Builder window, under Study 5, Reliability click Uncertainty Quantification.

In the Settings window for Uncertainty Quantification, locate the Quantities of Interest
section.

In the table, enter the following settings:

Function name Include study- True if Threshold

dependent input

Reduce to single global Larger than threshold 0.1
output

Uncertainty Quantification 4

In the Study toolbar, click = Compute.

The reliability analysis performs a so-called importance sampling that refines the full
model results near the threshold that we give for our quantity of interest. Recall that we
are here asking for the probability that this angle exceeds 0.1 degree. The reliability
analysis study gives us a table named Probability for condition having the value ~0.003.
This means that with the given conditions, there is a ~0.3% risk of the misalignment
angle to exceed 0.1 degree.

As a final step, we can also produce a response surface of pairs of input parameters, in this
case the Side length (1s) and the Cross plate width (wp) .

Uncertainty Quantification

1
2

In the Model Builder window, under Study 5, Reliability click Uncertainty Quantification.

Locate the Surrogate-Based Response Surface section. Click Response Surface in the
upper-right corner of the section.

RESULTS

Response surface

Click the Zoom Extents button in the Graphics toolbar.
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2 In the Model Builder window, under Results click Response surface.

Table Surface: gpm2_1

m

x107

0.35
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